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Modeling a dragon with NURBS in Maya:

This piece of article will show you step by step of how the dragon is created using
Maya. There are three type of modeling method in Maya, NURBS modeling,
Subdivision modeling and Polygon modeling, each of them have their advantages
and disadvantages. However we will build the dragon using patch NURBS surface
techniques. The tools that I use to model this dragon are Birail tools, NURBS
primitive, Fillet Blend Tools and etc.

In the first section, I will show you how the dragon is created by using Maya. Next
section, texturing the dragon will be shown. We need to paint the texture and
create bump map in PhotoShop, but before that, I will need Deep Paint 3D to create
reference line on how the texture will be distorted by NURBS. The detail will be
covered in the texturing section.

Before I start launching Maya, I will do some concept sketching on paper. This is
important, as it will be easier for me to visualise the object I have in mind later on. I
wanted to create a dragon between realistic and imaginative. I want it to look like a
T-Rex but with horn and larger forelimbs. Only the side orthographic is needed to
create the model. When I have done, I will scan in the sketch and save it as JPEG.
(Figure 1)

Modeling a dragon with NURBS in Maya

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/Modeling_dragon.html (1 of 4) [2000-06-10 23.53.44]

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/qjpg/Image1.jpg


(Figure 1)

Creating Image Planes
1.Select Multilister from Window menu, from camera tab double click side camera or
Ctrl-a to open Attributes Editor. Scroll down the list of entries until you see
Environment pop-up menu. Click on the Create Image Plane button.

2.In Image Name option, click Browse and load the JPEG file as reference for
modeling. (Figure 2)
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(Figure 2)

3.Now, I will translate the image plane further away from axis X origin, so as to avoid
any intersection with my model. From image Plane, Attribute, scroll down to
Placement Extras. Key in -5 in the first input field. (Figure 3)
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(Figure 3)
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Modeling the Head
1.Go to Create, EP Curve Tool. Note that curve created by EP Curve Tool will pass
through every point you draw. Press Enter to confirm when done.

2.In side view window, draw 2 separate curve as shown. Select second curve, press
F8 to switch to Components selection mode if it is in Objects selection mode. Hold
down RMB to invoke hotbox and select Edit point. After select curve's Edit Point,
press w to activate move tool then pulls points along X-axis. Remember not to edit
the first point near the nose. (Figure 4)
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(Figure 4)

3.Now, I will rebuild the curve that I'd drawn to uniform number of spans. First is to
ensure that uniform count of spans will form better surface. Secondly is to reduce
spans count of surface, since I don't want to have so many points to push and pull
around. Do not worry about the detail part, it can always been done by inserting
isoparm to the surface. Press F3 to toggle to Modeling menu. Select curves that
have been created. Go to Edit Curve, Rebuild Curve, options. Key in 10 for Number
of Spans. Click Rebuild. Rebuild next curve too.

4.From Status Line select Snap to Curve. (Figure 5)

(Figure 5)

5. With the snap to curve activated, then select EP Curve Tool. Hold down LMB
along first curve, you will notice that the first EP point is snapping on the curve.
Snap the end point to second curve then press enter. Create another curve at both
curve ends. I edit the last curve but leave third curve in the origin x-axis. Then I
rebuild these 2 curves to 4 spans curve. (Figure 6)
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(Figure 6)

6.Turn off grid from Display, Grid. Now go to Surfaces, Birail-2 select 2 profile
curves and then select 2 rail curves.

7.After surface is formed, press 5 to turn on smooth shade, then press 3 to display
highest smoothness. Make sure you are in Components selection mode (Press F8 to
switch), hold down RMB to select Hull, and again select Control Vertex from hot box.
Keep pulling CV, using direction arrow to toggle point to point until you get
something similar to the picture shown. (Figure 7) When I feel I need more CV to
control certain part, just click on RMB, from the hotbox select isoparm. Click on any
isoparm and drag it to the area that you would like to add in more detail, then go to
Edit Surface, Insert Isoparm. After you have satisfy of what you have done, then
select the surface, go to Edit, Delete by Type, History to delete construction
history.
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(Figure 7)

8. Now I will model the jaw using the same method as above to create 4 curves, but
only curve marked in red will be edited (pull the CV along X-axis). (Figure 8)
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(Figure 8)

Rebuild curves, Birail-2 to form surface and then delete the history of the surface.
Let¡¦s see what we have now. (Figure 9)

(Figure 9)

9. Select both head and jaw, go to Edit, Duplicate, options set the first Scale input
field to -1, Number of Copies to 1, Geometry Type to Copy. Then press Duplicate
button.

10. Now we will start stitching the surface to create seamless model. Select both
head surfaces, go to Edit Surfaces, Stitch, Global Stitch, options. Set the following
setting and press Global Stitch. (Figure 10)
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(Figure 10)

If there are gab between surfaces, just play around with difference Max Separation
value. The jaw surface was stitched with same method. With Global Stitch, there is
no need to select both surfaces isoparm and stitch edges. It help to save time when
you have a lot of surfaces to stitch!
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Creating an Eye
11.We shall now create an eye for the dragon. Before we start, select all the
surfaces, then go to Display, Hide, Hide Selection. First, I created a NURBS sphere,
then translate and scale it to the position of an eyeball. When it¡¦s done, select the
sphere and hold down RMB to invoke hotbox then go to Actions, Template the
eyeball.

12.Next use EP Curve Tool to draw a curve. Snap the start point to end point to
create a circle. After that, go to Edit Curves, Open/Close Curves to close the curve.
From there duplicate another 4 curves and scale them to 4 difference sizes. Before
you scale, go to Modify, Center Pivot. This will put pivot point of the circle to the
centre. After this is done, select the curves in order, then perform Loft from
Surfaces menu. Press 3 for hi-res display, then delete construction history of the
Lofted surface. And also don¡¦t forget to delete the 4 curves that we use to create
surface. (Figure 11)

 

(Figure 11)

13.Hold down RMB to select Hull, then select again Control Vertex from hotbox.
Keep on pulling CV, using key pad¡¦s direction arrow to toggle from point to point
until you get something similar like picture shown (Figure 12). Make sure the eyelid
fit properly to the eyeball.
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(Figure 12)

14.Then group them together and translate it above the head model. We are going
make a hole out of its head! (Figure 13)
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(Figure 13)

15.Select the eyelid, RMB to select the edge isoparm. Go to Edit Curves, Duplicate
Surface Curves. This will create a curve circle base on the isoparm that you selected.
Then go to Modify, Center Pivot. Finally scale it slightly bigger then the eyelid's
surface. (Figure 14)
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(Figure 14)

16.We will project this curve on to the head. Select both head surfaces and curve,
switch to side orthographic view. Go to Edit Surfaces, Project Curve On Surface,
Options. Project Along Active View should be selected. Then click on Project button.
This will project the curve on to the surfaces base on the active view; in this case I
want it to project from side orthographic so that it will project a similar circle on
both head surface. If it¡¦s project from perspective view, you will get a strange and
awkward result of curve on surface. Now, let¡¦s take a look at figure 15, the one
that I have circle in red was to show the curve that projected on the head surfaces.
(Figure 15)
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(Figure 15)

17.Select the surface then go to Edit Surfaces, Trim tool. The surface should have
transform into white wireframe (not show in Figure 16). (Figure 16)

(Figure 16)

Click on the surface that we want to retain, a yellow dot will appear when clicked
then press Enter to confirm the trim. Press 3 for hi-res display. Repeat the same
procedure for the other side of the head surface. (Figure 17) Delete curves that use
for projection when done.

Creating an Eye

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/Modeling_eyes.html (6 of 8) [2000-06-10 23.55.06]

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/qjpg/Image16.jpg
http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/qjpg/Image17.jpg


(Figure 17)

18.I will create a fillet blend between the gab. Select isoparm of eyelid edge, and
then shift select Trim Edge of head surface with RMB. While both edges were
selected, go to Edit Surfaces, Surface Fillet, Freeform Fillet. Press 3 for hi-res
display. With construction history you can adjust the eyelid¡¦s edge and the fillet
surface will follow. Once you are satisfy with the result, select the surface blend and
delete the construction history. (Figure 18)
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(Figure 18)

Creating an Eye

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/Modeling_eyes.html (8 of 8) [2000-06-10 23.55.06]

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/modeling/dragon/qjpg/Image19.jpg


Modeling Torso
19.Model the torso is easy, use the same method as I use to model the head. First I
use EP Curve Tool to create 4 curves on side orthographic. Each curve must
intersect with one another. Then I rebuild curves to the amount of span I want.
Always remember to keep less number of spans. You can always insert isoparm
when more detail is needed. I inserted some isoparm in the area where the neck
meet head, so as to create wrinkle below the neck. (Figure 19)

(Figure 19)

20.We can see there are an obvious seam where head joins the neck. (Figure 20)
Don¡¦t worry about the clear-cut of the seam, we will fix this with texture
transparency later when texture maps the dragon.
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(Figure 20)

21.To use Texture transparency to blend in 2 surfaces, we need to create another
surface. We will using Loft to create 3 spans surfaces. Firstly select head model,
then click on Make Live icon, notice that the surface turn into green wireframe.
Select EP Curve Tool and draw a curve on the surface. Next Make Live the neck
surface and draw curve on it. (Figure 21)
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(Figure 21)

Duplicate one of the curves by using Duplicate Surface Curves then place it in
between curves. Select curves in order, then perform Loft to create surface. (Figure
22)
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(Figure 22)
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Modeling Gum and Teeth
22.The gum is model from a NURBS plane. Before we start, template the head and
jaw. Select torso and go to Display, Hide, Hide Selection. Go to Create, NURBS
Primitives, Plane, Options. Set the patches U and V to 3 then translate to head
position and start to manipulate the CV to form a gum shape. (Figure 23) After that
mirror it and stitch it together.

(Figure 23)

23.Tooth is model with revolve technique. Turn on grid; Switch to side orthographic
view. Draw a curve on axis origin. Then go to Surfaces, Revolve. (Figure 24) For
future texturing, we will detach the model. The top part will be tooth and bottom
part will be gum. Select isoparm and go Edit Surfaces, Detach Surface. Then group
them together.
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(Figure 24)

24.Use the tooth we just model, duplicate, rotate and scale it to difference sizes.
Place them to upper and lower gums. (Figure 25) When you have done, group the
gum and teeth together.
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(Figure 25)

25.Now duplicate the tooth again and scale them to a larger size, pull the CVs to
make them into horn like shape and place them on the head as horns. Copy a few
more and mirror it to something similar as Figure 26. (Figure 26)
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(Figure 26)

At last the head of the dragon was completed. Next we will build the dragon's leg.
we will build the dragon's leg.

l>
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Modeling Legs(part I)
26.The leg is created from a cylinder. First, we create a NURBS cylinder, from
Channels box, click on Sections, hold down MMB and drag. Note that the number in
input field is changing. We will change the number of Sections and Spans to 30.
When it is done, translate it to the position we want. (Figure 27)

(Figure 27)

27. We will deform the cylinder into the shape of leg. Before that, select the
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cylinder, press F2 to switch to Animation, go to Deform, Create Lattice. An outline
box which surrounds the cylinder will appear. From Channels box change the S
Divisions to 2, T Divisions to 10, U Divisions to 4. (Figure 28)

(Figure 28)

28.Select the box that surrounds the cylinder, hold down RMB and select Lattice
Point from hotbox. Press w to activate move tool, select the first row of lattice
points and tilt it into a position as figure 29 shown. (Figure 29)
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(Figure 29)

29. This part will be fillet blend with torso in the future. Switch to side view, from
Shading, Shade Option, x-ray. This will make the cylinder become translucent so we
can pull points by referring to Image Plane. (Figure 30)
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(Figure 30)

30.Continue to pull, push, scale and rotate lattice points until it form into a leg
shape. When you are satisfied with it, select the cylinder and delete the
construction history to confirm the shape. (Figure 31)
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(Figure 31)
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Modeling Legs(part II)
31.Next, we will use Maya Artisan to sculpt the detail of the leg. Make sure the leg
is selected, go to Edit Surfaces, Sculpt Surface Tool. Hold down b key and MMB to
adjust the brush radius, m key and MMB to adjust the max displacement and start
sculpting the surface. Keep your finger near to z key to get ready for undo. (Figure
32)

(Figure 32)

32.When it is done use the same method of creating fillet blend for the eyes to
create fillet blend for the leg and torso. (Figure 33)
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(Figure 33)

33.We will use the same method to create fore limb for the dragon. (Figure 34)
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(Figure 34)

34.Well, we still need toes and fingers to complete the dragon. The toe can be done
by using the same technique as horn and teeth, which is revolving from curve. You
can use CV pulling or Artisan to sculpt it into the shape you wants. (Figure 35)

(Figure 35)

35.Basically, the fingers are just the same model as toe. From the first toe I had
made, I duplicate it, scale it, rotate it and pull the CVs into the shape of finger and
place them on to their positions. Instead of fillet blend so many fingers and toes, I
decided to use texture transparency to blend the surface. This will help to save up a
lot of time. So what I do is to make sure the fingers is intersect properly on to the
palm. (Figure 36)
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(Figure 36)

36.Finally, we have completed the entire model. We can now mirror it to form a
complete dragon. Do you still remember in the early part, we had mirrored the head
and jaw of dragon and stitched them together. We will now apply the same
technique to the body. Group all the part you want to mirror and name it as body.
Go to Window, Hypergraph to call up hypergraph window. Select the body group
from hypergraph and mirror it to form a complete model. The modeling of the
dragon is thus completed. (Figure 37)
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(Figure 37)
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Texture Map NURBS Dragon

In this section, I would like to use Deep Paint 3D to help me to indicate the location of UV on the
NURBS surfaces. But 3D Paint package only recognizes polygons with UV. So, we need to convert
NURBS to polygon, then export the polygons to 3D paint program. First, I will create bump map in
3D-paint program, and then I will use PhotoShop to define the bump map. Let start now,

1.Rename all the surfaces you had created, you can do this in the modeling stage.
Select a surface, in the Channels window, key in a proper name for your surface.

2.After renamed all the surfaces; I will apply a material for the surfaces.In this case, I would like to
use Blinn for the skin as Blinn has the Softest specular highlight among the rest.

Open up the Hypershade window, from the visor window's material folder, MMB drag the Blinn to
the working space. (Figure 38).
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(Figure 38)

Shift select the surfaces that u wish to assign to Blinn material, then point your mouse to Blinn in
working space, Left click on Blinn (don't let go, a menu will pop- up, select Assign Material to
Selected. (Figure 39)

(Figure 39)

3. Toggle to Rendering mode; create a Direction Light from light panel. Place it to light up
your model. Save your work.

4.1 Now, we going to convert NURBS to polygons for Deep Paint 3D.I will going to do it part
by part. First, I will do for left side head. Select the left side head, toggle to Modeling mode,
go to Display->NURBS components->Normal (shaded mode) to check the Surface Normal is
pointing out. Go to your perspective window, in the Shading panel->smooth Shade Selected
Item to view the result. If the "hair" pointing in, go to Edit Surface panel->Reverse Surface
Direction. This is to make sure that the polygon¡¦s surface normal point to the correct
direction (Figure 40)
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(Figure 40)

4.2 While the surface still selected, go to Polygons panel->NURBS to Polygon options. Set
number U & V to 24. Click Tessellate. Move up the polygons, Now you will have the
polygons Left Head and NURBS Left Head still remain. (Figure 41)
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(Figure 41)

4.3 Go to your Window panel -> General editor ->Plug-in Manager, select obj. Export.mll to
loaded and auto load. Now, have your Lt_Head selected polygon, go to File->Export
Selection's options, pick the file type as OBJexport, then save it to obj directory under your
project directory or any directory that you like.
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5.1 Ok, we are going to leave Maya for a while. Launch any paint package that you like to
import the Lt_Head. I will use Deep Paint 3D in this work. File -> open to the directory
contain Lt_Head. obj and you will see this Material import window. In the Object column,
your will find UV word, that's mean your polygons are prepared with UV, It's ready to paint!
(Figure 42)

(Figure 42)

5.2Click on the Material column's gray area to call up Set Material Size window, enter your
texture size. It's good to keep your master copy texture in higher resolution that u can scale it
down later according to your needs.

5.3 I prefer to work on bump map as a colour map in grey rather then paint the real bump on
the model. So I click on C (colour) in Material Channel, then click on colour in Add New
Channel. Select white as my colour and will get this. (Figure43)
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(Figure43)

5.4 After painted (figure 44)

5

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/texturing/Nurb_dragon/Texture1-2.html (2 of 8) [2000-06-11 00.03.50]

http://micro.ee.nthu.edu.tw/~u850961/tutor/html/texturing/Nurb_dragon/qjpg/Image45.jpg


(figure 44)

click on export material to photoshop icon to further define the texture in photoshop. (Figure
45)
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(Figure 45)

or save your image in 2D file format for Photoshop.

5.5 This is my final bump map for Lt_Head. (Figure 46) Save your work to popular file type
such as Targa in your texture directory.

(Figure 46)

5.6 From the bump texture, I used Photoshop's layering capability to create my colour map
(Figure 47)
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(Figure 47)

as well as specular map. (Figure 48)
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(Figure 48)

This texture can be reused to it mirrored or duplicated object without redraw your textures. It
perfectly matches to them. So you only need to do for left side head 's colour, bump and
specular and these are reusable for right side head. As well as one side of limb for map 2
side.

5.7 I repeat these steps from 4.1 to 5.6 for the rest of the surfaces that I wish to do 2D
mapping. (Figure 49)
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(Figure 49)

5.8 As I proceed to the body, I found out that the creature's body in a piece is pretty hard to
control my mapping, so I decided to detach it and rename them into 3 different surfaces:
neck, torso and tail. Then stitched them back accordingly. (Figure 50)

(Figure 50)
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5.9 I deleted all of the polygon geometry in Maya after I completed my 2D textures paint
because I going to use this textures map as UV map for my NURBS geometry. To delete all
polygons geometry, go to Edit panel ->Select All by Type -> Polygon Geometry then press
Backspace key to delete them. Now we remain all the NURBS as beginning stage.

press Backspace key to delete them. Now we remain all the NURBS as beginning stage.
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Using Triple Shading Switch to Shade the Creature

This is the time to see how our textures go with the surfaces. As u can see, I will assign
colour, bump and specular map to Blinn material. I'm going to use Switch node to enable me
to specify a shading group for many objects to have different characteristic within the shaded
members.

1.Open Hypershade window and locate the early created Blinn. Rename it to Skin. Double
click on it to bring up it's Attribute Editor.

2.Click on the colour's map button (Figure52)

(Figure52)

and you will bring up Create Render Node window.

3.As for colour maps; the Triple Shading Switch will allow the switching of three-channel
values (RGB). With this switch you can have a single shader control the general surface
attribute of many objects but different texture of each object. Click on Utilities tab ->Switch
Utilities->Triple Shading Switch. (Figure 53)
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(Figure 53)

4. Open Outliner window, put it beside Triple Shading Switch1 Attribute Editor window,
select the renamed surface, MMB drag to inshape's column. (Figure 54)

(Figure 54)

5.Click on Lt_head's inTriple column, then click on Map Item on the above will bring up
Create Render Node window. Click on File under Texture's tab (figure 55)
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(figure 55)

and will bring you to this window. (Figure 56)

¡@

load the texture from your textures directory and change the "File #" to" Lt_Head colour".
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(Figure 56)

6.Go to your perspective window's press 6 to turn on Hardware Texturing. (Figure 57)

(Figure 57)
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7.Repeat step 5 for the rest of inTriple's column. (Figure 58)

(Figure 58)

8.I will use the same way to map specular maps to the surfaces. Now, double click on the
Skin (Blinn) from the Hypershade window's working space to bring up its attribute window.

9.This time, I will click on Specular Colour's map button to add in Triple Shading Switch to
allow the Skin (Blinn)'s shader to control the general surface attribute of many objects but
different specular map of each object. (Figure 59)
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(Figure 59)

You may want to take a look at Hypershader's workspace to view the connection between
them. Right click and hold on the Skin (Blinn) to bring up a pop-up menu, select Graph
Shader Network to view their render connection. (Figure 60)
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(Figure 60)

To see how's the specular maps placed on the model, go to the Skin's Attribute Editor,
expend Hardware Texturing, select specular color. (Figure 61)
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(Figure 61)
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Using Single Shading Switch to Map Bump Maps

The Single Shading Switch allows the switching of single float attributes, for example, bump
depth.

1, Bring up the Skin (Blinn) attribute, click on Bump mapping's map button, click on Utilities
tab and select Bump 2d. (Figure 62)

(Figure 62)

2. From the Bump 2d window, click on Bump Value's map button, Utilities Tab and Single
Shading Switch. (Figure 63)

(Figure 63)

3. Doing the same way as before to load In Shape and In Single. (Figure 64).
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(Figure 64)

You may want to do a test render to view the result.
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Map with procedural map.

I will use Maya's build in procedural map to map the horns, nails and teeth.

1. Create a Phong rename it to "horns" and assign it to horn's models.

2.To create bump map for the horns .In the Hypershade window, MMB drag and drop bump
2d on the Phong's node. Then MMB drag and drop Fractral on Bump 2d node to create
render network (figure 65)

(figure 65)

Perform a test render using IPR render view. Select an area in IPR window, tune the bump
2d and fractral node to have interactive update of your rendering image. Colour and noise
were added using the drag and drop way. (figure 66)
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(figure 66)

After I've done, I use the same way to create textures for nails and teeth. Check all the
geometry with texture map in Hardware Texturing mode. (Figure 66a)
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(Figure 66a)

Fine Tuning with IPR

We are completed mapping the creature. The last thing to do is fine-tune the materials'
attribute that we assigned in early. IPR will do a great job in this aspect. But before that, you
need to setup some lights to light-up your character. (Figure 67)
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(Figure 67)

I open up the attribute and adjust some value to see how they influent the model. After I
satisfy with the setting, I create a fill light, a back light and a bounce light to make the
character more interesting. Perform a final render (figure 69)
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(figure 69)

E-mail : keongputer@hotmail.com
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